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XMI	Add-In	allows	UML	to	exchange	modeling	information	between	StarUML
and	XMI	suppoeted-different	modeling	tools	by	using	XMI(XML	Metadate
Interchange).	Use	XMI	Add-In	if	you	want	to	import		the	designed	information
by	using	UML	in	XMI	supported-other	modeling	tool	from	StarUML	or	to
import	modeling	information	in	StarUML	from	XMI	supported-other	modeling
tool.
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This	chapter	contains	a	general	overview	of	XMI	Add-In.	Included	are	a	brief
introduction	of	XMI	and	descriptions	of	XMI	Add-In	functions	and
configurations.

XMI	Concepts

XMI	Add-In	Functions

XMI	Add-In	Configurations
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XMI	Concepts

XMI	(XML	Metadata	Interchange)	is	an	OMG	standard	specification	for	mutual
exchange	of	metadata	between	UML-based	modeling	tools.	If	a	UML	modeling
tool	saves	modeling	information	in	the	XMI	format,	other	UML	modeling	tools
can	read	this	information	as	well.	For	this,	all	UML	modeling	tools	must
support	XMI,	and	many	UML	tools	in	the	market	currently	do	support	it.

For	more	information	on	XMI,	please	visit	the	OMG	web	site.
OMG	(Object	Management	Group)	-	http://www.omg.org

XMI	Versions

There	are	several	XMI	versions	depending	on	the	UML	version.	Each	version
has	a	few	differences.	StarUML(tm)	XMI	Add-In	supports	XMI	version	1.1,
which	is	currently	the	most	widely	used	XMI	version.

So	far	the	official	OMG	XMI	specifications	have	specified	only	the	standards
for	mutual	exchange	of	information	for	model	elements,	and	exchange
standards	for	diagrams	and	view	elements	have	been	excluded.	However,	as	the
need	for	mutual	exchange	of	information	for	diagrams	increases,	the	industry
widely	employs	a	specification	called	Unisys	XMI,	which	adds	specifications
for	diagram	and	view	elements	to	XMI	1.1.	StarUML(tm)	XMI	Add-In	supports
this	Unisys	XMI	format.

XMI	Support	by	Other	UML	Modeling	Tools

Many	UML	modeling	tools	currently	in	the	market	support	XMI	and	provide
data	compatibility	with	other	modeling	tools.	Nevertheless,	some	modeling
tools	require	additional	installation	processes	to	enable	XMI	functionality,	and
as	yet	some	tools	do	not	have	XMI	functionality	at	all.	For	information	on	using
XMI	in	a	specific	modeling	tool,	please	direct	your	inquiries	to	the	developer	or
vendor.

Note

Some	modeling	information	may	be	lost	or	modified	when	exchanging
modeling	information	between	UML	modeling	tools	using	XMI.	This	is
because	of	the	unique	features	of	each	modeling	tool,	especially	those	non-

http://www.omg.org


standard	features	that	do	not	comply	with	the	UML	standard.
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There	are	two	main	functions	of	XMI	Add-In:	importing	XMI	format	files	to
StarUML(tm)	and	exporting	StarUML(tm)	modeling	information	as	XMI
format	files.

Importing	XMI

Use	this	function	to	import	XMI	format	files	from	other	XMI-supporting
modeling	tools	to	StarUML(tm).	The	user	can	review	or	edit	any	parts	of	the
imported	XMI	files	and	save	them	as	StarUML(tm)	project	files	(.uml)	and
other	formats.	XMI	Add-In	also	intelligently	extracts	and	displays	information
such	as	the	XMI	version	and	UML	version	of	the	XMI	file	to	be	imported.

See	the	following	help	section	for	help	on	using	the	XMI	import	function.
Importing	XMI	Files

Exporting	XMI

Use	this	function	to	export	StarUML(tm)	modeling	information	to	other	XMI-
supporting	UML	modeling	tools.	The	user	can	export	modeling	information
either	in	the	standard	XMI	format	or	in	the	extended	XMI	format	with	diagram
information.	XMI	files	exported	from	StarUML(tm)	are	saved	as	XML
(eXtensible	Markup	Language)	format	files.

See	the	following	help	section	for	help	on	using	the	XMI	export	function.
Exporting	XMI	Files

Note

StarUML(tm)	XMI	Add-In	supports	imports	and	exports	for	XMI	1.1	and
Unisys	XMI	1.1,	which	includes	diagram	information.
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Once	XMI	Add-In	is	installed,	it	is	enabled	for	use	in	StarUML(tm)	by	default.
Installed	Add-Ins	can	be	enabled	or	disabled	through	Add-In	Manager	in
StarUML(tm).	If	an	Add-In	is	disabled,	no	main	menu	and	popup	menu	items
related	to	it	are	displayed,	and	no	StarUML(tm)	events	are	relayed	to	it.

Procedure	for	Enabling	XMI	Add-In	:

1. Select	the	[Tools]->[Add-In	Manager...]	menu	in	StarUML(tm).

2.
At	the	Add-In	Manager	dialog	box,	check	the	"XMI	Add-In"	checkbox	in	the

Add-In	list.

	

3. Click	the	[OK]	button	to	close	the	dialog	box.
	
Procedure	for	Disabling	XMI	Add-In	:

	
1. Select	the	[Tools]->[Add-In	Manager..]	menu	in	StarUML(tm).

2.
At	the	Add-In	Manager	dialog	box,	uncheck	the	"XMI	Add-In"	checkbox	in

the	Add-In	list.

3. Click	the	[OK]	button	to	close	the	dialog	box.
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This	chapter	describes	how	to	use	the	XMI	Add-In	functions:	importing	XMI
files	and	exporting	XMI	files.

Importing	XMI	Files

Exporting	XMI	Files

	
	



Importing	XMI	Files Top		Previous		Next

This	function	imports	XMI	files	saved	by	other	modeling	tools	to
StarUML(tm).

Procedure	for	Importing	XMI	Files	:

1. Select	the	[File]->[Import]->[XMI	...]	menu.

2.
At	the	Import	XMI	dialog	box,	click	the	[Browse...]	button	to	activate	the

Select	XMI	File	dialog	box.

	

3. Select	an	XMI	file	to	import	and	click	the	[Open]	button.



	

4.
Examine	the	option	items	in	the	Import	XMI	dialog	box	and	check	the

necessary	options.

5. Click	the	[Execute]	button	to	import	the	XMI	file.
	
Options

There	are	a	few	options	available	for	importing	XMI	files.

Item Description

Generate
diagram
and	views

Specifies	whether	to	generate	a	diagram	and	its	view	elements.	If
unchecked,	diagram	and	view	elements	are	not	generated.	This
option	has	no	effect	on	standard	XMI	format	files	that	do	not
contain	diagram	information.

Create	a
new	project

Specifies	whether	to	create	a	new	project	with	the	modeling
information	from	the	imported	XMI	file.	If	a	project	is	already
open	when	importing	an	XMI	file	with	this	option,	the	earlier
project	will	be	closed	automatically.

Use
Rational

Specifies	whether	to	apply	Rational	Approach	when	creating	a	new
project	with	the	modeling	information	from	the	imported	XMI	file.
This	option	is	automatically	selected	when	importing	XMI	files



Approach saved	in	Rational	Rose.	Although	the	user	can	deselect	this	option,
it	is	highly	recommended	to	use	it	when	importing	XMI	files	saved
in	Rational	Rose.

Note

The	extension	name	for	XMI	format	files	must	be	either	.xml	or	.xmi.
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This	function	exports	StarUML(tm)	modeling	information	as	XMI	format	files.
The	saved	XMI	files	can	be	read	by	other	UML	modeling	tools.

Procedure	for	Exporting	XMI	Files	:

1. Select	the	[File]->[Export]->[XMI	...]	menu.

2.
At	the	Export	XMI	dialog	box,	click	the	[...]	button	to	activate	the	Save	as

XMI	File	dialog	box.

3.
Specify	the	path	and	file	name	for	the	XMI	file	to	save,	and	click	the	[Save]

button.



	

4.
Examine	the	option	items	in	the	Export	XMI	File	dialog	box	and	check	the

necessary	options.

5. Click	the	[Execute]	button	to	export	the	XMI	file.
	
Options

The	following	options	are	available	for	exporting	XMI	files.

Item Description

XMI
version

Specifies	the	XMI	version.	XMI	Add-In	supports	the	standard	XMI
1.1	and	Unisys	XMI	1.1,	which	is	extended	to	include	diagram
information.	Select	"XMI	1.1	for	UML	1.3"	to	export	in	the
standard	XMI	format,	or	select	"XMI	1.1	for	UML	1.3	Rose
Extended"	to	include	diagram	and	view	information.

Include
diagram
and	view
information

Explicitly	specifies	whether	to	include	diagram	and	view
information,	if	"XMI	1.1	for	UML	1.3	Rose	Extended"	is	selected
under	the	XMI	version	option.

Generate
UUID

Specifies	whether	to	insert	UUID	(Universal	Unique	IDentifier)	in
all	XMI	elements	for	UML	modeling	elements.



Generate
Timestamp

Specifies	whether	to	insert	file	generation	time	information	in	the
XML	file.

Note

The	extension	name	for	XMI	format	files	must	be	either	.xml	or	.xmi
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The	following	are	frequently	asked	questions	and	answers	for	XMI	Add-In.

General

1. The	StarUML(tm)	menu	does	not	show	XMI-related	menu	items.

2. Which	XMI	versions	are	supported	by	XMI	Add-In?

3. How	do	I	use	the	XMI	functions	in	IBM	Rational	Rose?

4. How	should	I	configure	the	export	XMI	options	in	IBM	Rational	Rose?

5. How	should	I	configure	the	export	XMI	options	in	Borland	Together?

Importing/Exporting	XMI

1. Non-Latin	characters	display	incorrectly	in	the	XMI	files	exported	by	IBM
Rational	Rose.
	

2. The	Dependency/Extend/Include	elements	of	Use	Case	Diagram	are	notconverted	in	the	XMI	files	exported	by	IBM	Rational	Rose.
	

3. Association	(connection)	elements	of	Deployment	Diagram	are	notconverted	in	the	XMI	files	exported	by	IBM	Rational	Rose.
	

4. Some	stereotypes	are	not	converted	in	the	XMI	files	exported	by	IBM
Rational	Rose.
	

5. Statechart	Diagram	under	the	State	element	is	not	converted	in	the	XMI	files
exported	by	IBM	Rational	Rose.
	

6. Destruction	Mark	of	Sequence	Diagram	is	not	converted	in	the	XMI	files
exported	by	IBM	Rational	Rose.
	



7. Sequence	Diagrams	are	not	generated	in	some	of	the	XMI	files	exported	by
IBM	Rational	Rose.
	

8. The	"incorrect	encoding"	error	occurs	when	reading	XMI	files	exported	by
Borland	Together.
	

9. Extend/Include	elements	of	Use	Case	Diagram	are	generated	as	Associationelements	in	the	XMI	files	exported	by	Borland	Together.
	

10. Object	elements	are	converted	as	ClassifierRole	elements.
	

11. Diagram	view	elements	have	different	coordinates	and	shapes.
	

General

1. The	StarUML(tm)	menu	does	not	show	XMI-related	menu	items.
	
There	are	two	possible	reasons	why	the	menu	does	not	show	up.	One	is	that
XMI	Add-In	is	not	installed	in	StarUML(tm)	or	related	files	are	damaged.
To	correct	this,	run	the	installation	program	to	reinstall	StarUML(tm)	or
select	to	reinstall	XMI	Add-In	only.	If	you	are	familiar	with	the	structure	of
StarUML(tm)	Add-Ins,	you	may	examine	the	registry	or	menu	files	to
check	for	damage	in	the	Add-In	and	correct	the	problem.	Another	possible
reason	for	the	problem	is	that	XMI	Add-In	is	disabled	by	Add-In	Manager.
If	so,	go	to	Add-In	Manager	and	enable	XMI	Add-In.	For	the	procedure	to
enable	XMI	Add-In,	see	the	section	on	XMI	Add-In	Configurations.
	

	
2.Which	XMI	versions	are	supported	by	XMI	Add-In?

	
XMI	Add-In	supports	XMI	1.1,	which	is	the	most	widely	used	version	in
the	market	today,	and	Unisys	XMI	1.1,	which	is	extended	to	include
diagram	information	in	XMI.	In	other	words,	XMI	Add-In	can	be	used	to
read	and	write	XMI	1.1	(Unisys	XMI	1.1)	format	files.
	



3. How	do	I	use	the	XMI	functions	in	IBM	Rational	Rose?
	
In	order	to	use	the	XMI	functions	in	IBM	Rational	Rose,	you	need	to	have
an	Add-In	called	"Unisys	XML	Tools"	installed.	For	details	on	installing
and	using	the	Add-In,	please	refer	to	the	technical	documentation	or
support	provided	by	the	tool	vendor.
	

4. How	should	I	configure	the	export	XMI	options	in	IBM	Rational	Rose?
	
If	you	want	to	use	"Unisys	XML	Tools"	in	IBM	Rational	Rose	to	save	an
XMI	format	file	for	use	by	StarUML(tm)	XMI	Add-In,	save	the	file	as	an
"XMI	1.1"	file.
	

5. How	should	I	configure	the	export	XMI	options	in	Borland	Together?
	
If	you	want	to	save	an	XMI	file	in	Borland	Together	for	use	by
StarUML(tm)	XMI	Add-In,	it	is	recommended	to	save	the	file	as	"XMI	1.1
for	UML	1.3	(Unisys	Extension)"	or	"XMI	1.1	for	UML	1.3	(Unisys
Extension,	Recommended	for	Rose)".
	

Importing/Exporting	XMI

1. Non-Latin	characters	display	incorrectly	in	the	XMI	files	exported	by
IBM	Rational	Rose.
	
This	problem	occurs	because	IBM	Rational	Rose's	"Unisys	XML	Tools"
only	supports	"ISO-8859-1"	encoding	(English	only).	To	resolve	this,
please	direct	inquiries	to	IBM	Rational	customer	support	or	the	Unisys
XML	Tools	vendor.
	

2. The	Dependency/Extend/Include	elements	of	Use	Case	Diagram	are	notconverted	in	the	XMI	files	exported	by	IBM	Rational	Rose.
	
This	problem	occurs	because	Rational	Rose	omits	information	for	the
Dependency/Extend/Include	elements	of	Use	Case	Diagram	when	saving
XMI	files.
	



3. Association	(connection)	elements	of	Deployment	Diagram	are	notconverted	in	the	XMI	files	exported	by	IBM	Rational	Rose.
	
This	problem	occurs	because	Rational	Rose	omits	information	for
Association	(connection)	elements	of	Deployment	Diagram	when	saving
XMI	files.
	

4. Some	stereotypes	are	not	converted	in	the	XMI	files	exported	by	IBM
Rational	Rose.
	
This	problem	occurs	because	Rational	Rose	omits	information	for	some
stereotypes	such	as	"business	use	case",	"use-case	realization"	and
"ClassUtility"	when	saving	XMI	files.
	

5. Statechart	Diagram	under	the	State	element	is	not	converted	in	the	XMI
files	exported	by	IBM	Rational	Rose.
	
While	Rational	Rose	is	capable	of	generating	Statechart/Activity	Diagram
under	State	or	Activity	elements,	this	information	is	omitted	when	saving
XMI	files	because	it	is	conceptually	incorrect	for	UML.	This	information
cannot	be	restored.
	

	

6. Destruction	Mark	of	Sequence	Diagram	is	not	converted	in	the	XMI
files	exported	by	IBM	Rational	Rose.
	
While	Rational	Rose	is	capable	of	expressing	Destruction	Mark	in
Sequence	Diagram,	this	information	is	omitted	when	saving	XMI	files
because	there	is	no	appropriate	modeling	element	that	corresponds	to	it
under	the	UML	standard.	This	information	cannot	be	restored.
	
	

7. Sequence	Diagrams	are	not	generated	in	some	of	the	XMI	files	exported
by	IBM	Rational	Rose.
	
This	problem	occurs	because	when	saving	XMI	files	Rational	Rose	omits
information	for	Sequence	Diagram	that	does	not	contain	any	message



elements.
	
	

8. The	"incorrect	encoding"	error	occurs	when	reading	XMI	files	exported
by	Borland	Together.
	
Borland	Together	incorrectly	writes	XML	file	encoding	values	when	saving
XMI	files.	For	instance,	hyphens	("-")	in	values	such	as	"ISO8859_1"	and
"EUC_KR"	are	incorrectly	replaced	by	underscores	"_".	Appropriate
corrections	must	be	made	to	the	XMI	files	saved	by	Together	before
importing	them	into	StarUML(tm).
	

	

9. Extend/Include	elements	of	Use	Case	Diagram	are	generated	asAssociation	elements	in	the	XMI	files	exported	by	Borland	Together.
	
If	either	the	'XMI	1.1	for	UML	1.3	(Unisys	Extension)'	or	'XMI	1.1	for
UML	1.3	(Unisys	Extension,	Recommended	for	Rose)'	option	is	selected,
Borland	Together	expresses	Extend/Include	elements	of	Use	Case	Diagram
as	Association	elements.
	

	
10. Object	elements	are	converted	as	ClassifierRole	elements.

	
Object	elements	generated	from	Sequence/Collaboration	Diagrams	in	IBM
Rational	Rose	or	Borland	Together	are	converted	as	ClassifierRole
elements.	This	is	because	Rose	and	Together	internally	treat	these	object
elements	as	ClassifierRole	elements	and	express	them	as	ClassifierRole
elements	when	saving	XMI	files.	Even	if	the	user	may	not	intend	object
elements	to	be	converted	as	ClassifierRole	elements,	this	is	conceptually
correct.
	

	
11. Diagram	view	elements	have	different	coordinates	and	shapes.

	
This	problem	occurs	because	information	for	diagram	view	elements	is



simplified	when	saving	XMI	files.	Some	UML	modeling	tools	also	omit
some
of	the	information	for	view	elements	when	saving	XMI	files.	This	varies
slightly	from	one	modeling	tool	to	another.
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